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1 Using this Document 
The DatuGram™3D User Guide will help you: 

 Understand the principles of operation of the software. 

 Plan and execute your fieldwork. 

 Use the software, make measurements and draw maps from the images in the office. 

Within this document, you will find comments, tips, and answers to frequently asked questions. 
These are indicated by the following admonitions: 

 This icon signifies comments that are important for the user. They will help you to 
make maximum use of the DatuGram™3D software. 

  

This icon signifies operational tips that may help you optimize your work in the field 
and in the office. 

  

  This icon signifies warnings that are important for the user.  
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2 Overview of DatuGram™3D 

2.1 Background 

DatuGram™3D software is a Field-to-Plan application allowing surveyors to make accurate 
geodetic measurements and draw draft CAD plans and maps directly from images 
photographed using standard digital cameras. DatuGram™3D is applicable for surveying 
projects on a 1:250 scale, such as as-built surveys, volumetric analysis of stockpiles, geodetic 
mapping of buildings, roads, tunnels, junctions, engineering structures, forensic and accident 
scenes, mines, earth works, archaeological artifacts, film sets, and much more. 

2.2 Principles of Operation 

The DatuGram™3D software employs the principles of 
photogrammetry. Photogrammetry is the science of taking 
accurate measurements from photographs. The output of 
photogrammetry is typically a CAD map, plan, drawing, or a 3D-
model of some real-world object or scene. 

 

Figure 1: Principles of Operation of DatuGram™3D 

DatuGram™3D automatically calculates the internal camera system parameters using a simple 
automatic self-calibration procedure, thus allowing the user to use any regular digital camera 
(1 – Figure 1). When uploading the images, DatuGram™3D employs image processing and 
bundle adjustment algorithms to automatically calculate the relative orientation of the images 
(2 and 3 – Figure 1), such that only two of the images must be geo-referenced. Subsequently, 
DatuGram™3D automatically locates any point the user marks on one image in at least two 

“photo” – light 
“gram” – drawing 
“metry” – measurement 
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additional images (4 – Figure 1), thus allowing DatuGram™3D to apply triangulation to find the 
3D-coordinates of the new point. This permits users to draft objects directly on one image while 
the application automatically finds them in all other images, thus eliminating the need for 
stereoscopic digitization of images. Moreover, DatuGram™3D allows the automatic extraction 
of a digital terrain model (DTM) of the survey area. This is highly useful for topographic surveys 
and volumetric analyses. While drafting on the images, the surveyor may use templates 
containing layers and codes. Consequently, the generated 3D model of the survey area may be 
saved in CAD DXF file format, so that it can be opened for further processing in any CAD 
software package. 

As a result, DatuGram™3D streamlines and accelerates the Field-to-Plan process, i.e., the 
process of capturing field data and the drafting of CAD maps and models from the data. 

2.3 Working with DatuGram™3D 

Working with DatuGram™3D is very simple. 

 

Figure 2: Working with DatuGram™3D 

2.3.1  In the Field 

The surveyor takes multiple photographs of the surveyed object or the survey area from 
different angles (1 – Figure 2), and measures the coordinates of several (minimum of three) 
reference points (or control points) using a total positioning station (TPS) or an RTK device, in 
either a local or national grid (2 – Figure 2), or alternatively measures two or more slope 
distances. The control points are used to geo-reference the images, i.e., anchor the images to the 
local or national grid, and the slope distances are used to correctly scale the whole project to 
allow seeing right measurements. 

2.3.2  In the Office 

The surveyor uploads the images to the DatuGramTM3D software that automatically associates 
all images to one another, by employing advanced image processing algorithms that find 
homological tie points and similar features, and calculates the relative orientation of the images. 
Optionally the surveyor can load the TPS measurement file of the control points and digitize at 
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least three of the control points in at least two of images each in order to geo-reference all 
images to the local or national grid. Or alternatively, choose to add scale-only without control 
points or geo-referencing (without orientation and position), by adding 2 slope distance 
measurements in two images each. Both geo-ref and scale are optional, hence it is possible to 
build and see a model without measurements. 

Users may then draft their CAD model directly on the images, or automatically generate a DTM 
for any topo-surface that appears in the images (3 – Figure 2). The DatuGramTM3D software 
ultimately produces a DXF file of the generated 3D CAD model, as well as a file that lists all the 
points that were measured from the images, specifying their names, associated codes, and 
(x,y,h) coordinates, as well as the accuracy of each measurement, i.e. the (x,y,h) residuals for 
each point. 

In addition, the surveyor may opt to highlight, on the geo-referenced images, any additional 
points that were measured by field crews. In this way, the user may verify the quality of the 
measurements undertaken by field crews and identify and correct in the office any discrepancy 
in the field measurements. 

 

 

Figure 3: Typical DatuGramTM3D Work Area Showing Control Points 

2.4 Accuracy of Measurements 

In geo-referenced or scaled jobs, the accuracy of measurements made on the images by 
DatuGram™3D depends on the following parameters: 

 The camera resolution and the distance between the camera and the measured 
object. The accuracy of measurements made on the images by DatuGram™3D is a factor of 
the camera’s resolution and the proximity to the measured object. Typically, an 18-
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megapixel camera provides a 1 to 2 centimeter (3 to 6 hundredth of a foot) measurement 
accuracy at a distance of about 100 to 150 meters (110 to 160 yards, 330 to 480 feet). 

 The precision with which measurements in the survey area are done. This refers to 
the coordinates of the reference control points or to the measured distances. These 
should be as exact as possible as they set an accuracy baseline for all the measurement and 
drafting related to the images. When you measure Ground control points, make sure you 
have several of them on a surface showing a very clear feature, such as marks on the ground 
or marks on walls.  This will assure taking a very precise measurement.  If you try to 
measure building corners using an RTK device on buildings you may have to get away from 
the corner a little bit to make sure that the laser is getting it.   

 The maximum angle between images of the surveyed area. The accuracy of 
measurements made on the images by DatuGram™3D is impaired when the maximum angle 
between images of the surveyed area is less than 30°. For best measurement accuracy, the 
maximum angle between images of the surveyed area should be close to 90°. 

 The scattering of the control points or measured distances and the accuracy of 
digitizing them in the images. For best measurement accuracy, control points for image 
geo-referencing should be chosen on the perimeter of the surveyed area and measured 
distances should be as long as possible so that measurements made on the images by 
DatuGram™3D are interpolated, rather than extrapolated, from the measured distances or 
points. Moreover, control points should be well distributed in 3D space, i.e., relative to both 
depth and height, and digitized as accurately as possible in the geo-referenced images. For 
more details on measuring control points in the field, please refer to Chapter 4. 

Various quality control measures in DatuGramTM3D provide the user with detailed information 
about the accuracy of measurements. First, after the images have been geo-referenced, 
DatuGramTM3D verifies the accuracy of the image geo-referencing or scaling by comparing the 
relative orientation of the control points or the distances to the relative orientation of the 
images. The Geo-Referencing Quality Indicator or Scale Quality Indicator provide color 
indication (green, yellow or red) of the accuracy of the referencing of the photogrammetric 
model. Furthermore, after calculating the coordinates of the new points measured from the 
images, DatuGramTM3D provides the accuracy of each measurement, i.e., the (x,y,h) residuals 
for every point. 
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3 Installing DatuGram™3D 

3.1 System Requirements 

The DatuGramTM3D software is designed to work on common office PCs and standard laptops. 

 Operating system requirements 

o Windows 7: Enterprise, Ultimate or Professional (64-bit only). 

o Windows 8.1: Enterprise or Professional (64-bit only). 

o Windows 10: Enterprise or Professional (64-bit only). 

 DatuGram™3D v4.5.0 will no longer support 32-bit operating systems. The 64-bit 
environment provides enhanced support for larger quantities of images and superior 
responsiveness.  

 CPU and hard disk requirements 

o CPU: minimum Intel core i5 (or equivalent); recommended i7. 

o CPU RAM: minimum 4GB RAM; recommended 8GB. 

o Hard disk: minimum 50GB of free space; recommended 100GB. 

 Screen and graphics card requirements 

o Display resolution: at least 1600X900 with True Color; recommended 1920x1080. 

o Graphics card: at least 0.5GB; recommended 1GB. 

 Connectivity requirements 

o Available Internet connection for installation, activation and updates. 

 Compatibility 

o DXF file format: DXF 2006 onwards. 

 

3.2 Installing DatuGram™3D 

3.2.1  Upgrading from V4.1.5 or lower to V4.5.0 or higher 

The setup files for V4.5.0 of DatuGramTM3D were built differently than V4.1.5, so to update from 
V4.1.5 to V4.5.0 you will need to uninstall V4.1.5 first, then run the installation of V4.5.0.  In 
future versions this will not be necessary. 

3.2.2  Important Information about DatuGramTM3D Version 4.5.0 
Backward Compatibility 

Version 4.5.0 of DatuGramTM3D contains major changes. In jobs created using DatuGramTM3D 
4.1.5 or earlier images will need to be relinked.  All control points and objects defined in the 
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prior version will be kept and may be used. Note that if you save the job in DatuGramTM3D 4.5.0 
(or a higher version), you will not be able to open the job in DatuGramTM3D 4.1.5 or earlier. 
 
Additionally, since starting from V4.5 all processing is handled under image clusters, all 
volumes calculated in jobs created in prior versions will need to be recalculated.  

 Opening a job that was saved using DatuGramTM3D V4.1.5 or earlier using 
DatuGramTM3D V4.5.0 requires running link images again.  Hence, it may produce results and 
reports that are slightly different than what was produced in the prior version.  It will be up to 
the user to make the decision as to if they want to continue or cancel out and keep the prior 
results. 

3.3 DatuGramTM3D Licenses 

3.3.1  Stand-Alone Software License 

A regular software license of DatuGramTM3D allows the installation of one copy of the software 
on a single computer or “seat”. This copy of the software may be re-installed on that computer, 
or transferred to another computer after uninstalling from the first computer. 

3.3.2  Network Software License 

A network license of DatuGramTM3D is intended for organizations that require the flexibility to 
be able to use DatuGram™3D on several computers on a local network. This licensing method 
enables installation of the DatuGram™3D application on any number of PCs in a local network. 
The application can be used concurrently on the number of computers, or “seats” that were 
purchased as part of the floating license. 
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3.4 Activating DatuGram™3D 

 If this is the first time the software is installed on your computer, the “DatuGram™3D 
Activation License” will open. You should provide a license key file (V2C file that you 
received from Datumate) or fill in the activation license request form. 

  

Figure 4: DatuGram™3D Activation License 

 If you have purchased a license, you should have received with the invoice, the License ID 
(LicID). Keep it for the activation step. 

 When the “Activation License Request” form is displayed fill in all the fields and click Send 
Request. 

 There are three types of licenses available: 

 Trial – this type of license is free of charge, and lets you use the full power of DatuGram™3D 
for a period of 30 days. To get this type of license you do not need a LicID. 

 Full – this is a full purchased license of DatuGram™3D for a single computer. 

 Network – this is a full purchased type of license, allowing installation of DatuGram™3D on 
several computers running on the same LAN (Local Area Network). 
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Figure 5: DatuGram™3D Trial License Request Dialog Box 

 

Figure 6: DatuGram™3D Full License Request Dialog Box 
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Figure 7: DatuGram™3D Network License Request Dialog Box 

 You will receive your license activation file (V2C file) by email. This may take up to one 
business day. 

 Upon receiving the V2C, save it and when DatuGram™3D starts, the “DatuGram™3D 
Activation License” window (Figure 4) is displayed again. Click on Load Activation File. 

 Browse to the location of the V2C license activation file and click on the file. That 
completes the activation process. 

 

Figure 8: Selecting the Licensing File 
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 If you have purchased a Network License, you can manage the number of available 
concurrent DatuGram™3D licenses by adding or removing LicIDs in the “Activation 
License Request” form (Figure 4). 

3.5 Reinstalling DatuGram™3D 

You may reinstall DatuGram™3D on the same computer any number of times. The installation 
process is identical to the initial installation process, and no activation is required. 

However, if any hardware changes have been made on that PC, such as CPU or hard disk 
upgrades, you may need to re-activate the software license. The re-activate process is similar 
that of transferring DatuGram™3D to a different computer (refer to Section 3.6.) 

3.6 Transferring DatuGram™3D to a Different Computer 

Each regular software license allows you to install the software on a single computer. You may 
transfer the software from one computer to another computer by contacting Datumate support 
in order to deactivate the original license and activate a new license on the new computer. 

3.7 Upgrading DatuGram™3D 

Datumate periodically releases software updates for DatuGram™3D. These updates include 
new functionality, compatibility to new operating system versions, bug fixes, and more. These 
updates are available for customers who are registered with Datumate’s Annual Support and 
Update Program. 

If you are eligible for software updates, it is highly recommended to install them upon their 
release by Datumate. Upon opening, the software will automatically check the availability of 
new versions and, if available, will notify the user about new version availability. Alternatively, 
to check for new software versions, click Help in the main menu and click Check for Updates. 

Checking for the availability of new versions requires Internet connectivity to 
Datumate’s website www.datumate.com. Please make sure you have proper Internet 
connectivity, and verify that your local Firewall does not block HTTP connection with 
Datumate’s website. 
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4 Field Work: Taking Photos and Measuring 
Control Points 

4.1 Choosing your Camera and Lens 

The following guidelines and recommendations will help you choose an optimal camera and 
lens for surveying work: 

Use a high-resolution camera. It is recommended to use a camera with at least an 18-
megapixel resolution. Typically, an 18-megapixel camera provides a 1 to 2 centimeter (3 to 6 
hundredth of a foot) measurement accuracy to a distance of about 100 to 150 meters (110 to 
160 yards, 330 to 480 feet). 

 DatuGram™3D does not support images taken with cameras having sensors greater 
than 36-megapixel because the application may not be able to contend with the resulting file 
size 

 

 Use a camera with a large CCD/CMOS sensor. It is recommended to use a camera with a 
CCD/CMOS sensor size larger than 100mm2. 
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Figure 9: Common CCD/CMOS Sensor Sizes used by Digital Cameras 

A camera with lower resolution and smaller sensor size can be used but this will 
degrade the measurement accuracy and the performance of the automatic algorithms of the 
software. For example, an 8-megapixel compact or smartphone camera with a 40mm2 sensor 
size will provide a measurement accuracy of 1 to 2 centimeter (3 to 6 hundredth of a foot) at a 
distance of only 30 to 40 meters (32 to 43 yards, 96 to 129 feet). 

 Use a lightweight camera with Wi-Fi connectivity. It is recommended to use a camera 
with body weight lower than 300 grams and Wi-Fi connectivity. This facilitates easier 
installation and operation of the camera on telescopic poles or small UAVs. 

 Use a wide-angle lens. It is recommended to use a wide-angle lens with fixed focal length 
between 8 and 16 mm. The wide angle provides a sufficiently broad field of view (FOV) to 
capture a spacious area when in close proximity to the target. This enhances the quality of 
measurements for images. 
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 Use a lens with a fixed focal length. DatuGramTM3D requires that the camera’s focal length 
will not change after the calibration of the camera and during the photographing of the survey 
area. Thus, it is strongly recommended to use a fixed focal length lens, i.e., a lens without optical 
zoom. 

 The recommended camera types that are particularly suitable for the requirements 
mentioned above are lightweight mirror-less digital cameras with interchangeable lenses 
and Wi-Fi connectivity. As of March 2016, the list of recommended camera models includes: 

o Sony A7R with full frame 35mm lens (36.4 megapixel, CMOS Sensor, 35mm 
format sensor = 861.6 mm2 sensor size, Wi-Fi connectivity, body weight 465 g) + 
Samsung 35 mm fixed lens. 

o Sony Alpha ILCE-A6000 (24 megapixel, mirror-less, interchangeable lens, APS-C 
format sensor = 370 mm2 sensor size, Wi-Fi connectivity, body weight 285 g) + Sony 
16 mm fixed lens. 

o Samsung NX Mini (21 megapixel, mirror-less, interchangeable lens, 1’’ BSI format 
sensor = 116 mm2 sensor size, Wi-Fi connectivity, body weight 158 g) + Samsung 9 
mm fixed lens. 

o DJI Phantom 3 – Professional (12 megapixels, 35mm format sensor, 20 mm fixed 
lens, FOV=94°). 

o  

4.2 Photographing the Survey Area 

The following guidelines and best practices will help you photograph the survey area in an 
optimal way: 

 Set your camera to maximum resolution. Note that some camera models are preset to 
photograph in a resolution lower than their maximum resolution. Make sure your camera is set 
to the maximum resolution available. 

 Assure that every point you want to measure appears in at least two images which 
have been taken at different positions. The key principles of photographing the survey area 
is that any point you want to measure should appear in at least three images from different 
viewing angles. The best measurement accuracy will be attained if the maximum angle of 
photography between the images will be 90°. 

 

Figure 10: Achieving Optimal Measurement Accuracy 
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 Elevate the camera above ground level to minimize foreground obstructions hiding 
features surveyed. Elevating your camera above ground level is a key success factor for 
employing close-range photogrammetry. Elevating the camera above ground level helps 
avoiding low-lying foreground obstructions such as fences, cars, and near ground vegetation, 
thus generating images of the survey area with minimal obstructions. Moreover, some 
techniques used to elevate the camera above ground level, such as installing the camera 
onboard a small quadcopter, allow a much faster process of photographing the surveyed area, 
thus significantly enhancing fieldwork productivity. 

 
Take photographs from an elevated vantage point, such as from the rear of a vehicle or from 
a building overlooking the survey area, or use a monopod to raise the camera several meters 
above ground level. Lightweight, portable telescopic poles intended for photography, allow 
taking pictures from 6 to 10 meters (20 to 30 feet) above ground level while remotely 
controlling the camera using the Wi-Fi function on a smartphone or a tablet. Another highly 
effective method to overcome obstructions is the use of small UAV copters. A UAV copter, 
flying at an altitude of 17 to 23 meters (50 to 70 feet), easily bypasses low-lying obstructions 
while the wide-angle lens of the camera (smaller than 16mm focal length) provides a very 
large field-of-view. 

 

Figure 11: Overcoming Low-Lying Obstructions 

 Modify the camera’s elevation for each image. This will ensure optimal measurement 
accuracy. 

 

Figure 12: Modifying the Camera’s Elevation 

 Take your images in good and consistent lighting conditions. Take all images in similar 
lighting conditions, preferably at the same time of the day. Avoid photographing the survey area 
during different times of the day. This will minimize changes in shadings and lighting conditions 
that may degrade the performance of the automatic image processing algorithms employed by 
DatuGramTM3D.  Do not take or use images of dark areas.  
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Figure 13: Examples of Changes in Shadings and Lighting Conditions 

 Take images only in landscape format. DatuGramTM3D does not support images in 
portrait format. If your camera is equipped with Auto Rotate functionality, set it to “Off” so that 
all images remain in landscape format. 

 

Figure 14: Correct and Incorrect Camera Positioning 

 If you use a zoom lens, do not change its settings while taking images. Modifying the 
zoom setting changes a camera’s calibration parameters. Thus, use a lens with fixed focal length 
rather than a lens with zoom capabilities. However, if you do use a zoom lens, set it to the widest 
field-of-view and do not change this setting when photographing. 

 Take a large number of images of the survey area from different viewing angles. The 
more images from different viewing angles you take of the survey area, the better the automatic 
algorithms will perform in associating the images and detecting new points. To achieve optimal 
results, take at least 20 to 30 consecutive images of your survey area from different viewing 
angles.  It is possible to work with up to 200 images to cover larger area. 

 Maintain a consecutive order of the images. While photographing the survey area, 
maintain a consecutive order of the images. This will ensure optimal performance of the 
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automatic algorithms for associating images and detecting new points.  If you do not do this you 
will need to manually order the images after loading them into the software which may be a 
lengthy process. 

 

 

Figure 15: Maintaining a Consecutive Order of Images 

 Surveying an object (façade, landmark, etc.). To survey an object, such as a façade or 
landmark, take 20 to 30 consecutive images as you walk along the object. Take a new image 
every few meters while keeping the camera centered on the center of the object. Elevate the 
camera above ground level to minimize obstructions, and slightly modify the elevation of your 
camera between images. 

 

Figure 16: Surveying an Object 

 Surveying an area (intersection, bridge, etc.). To survey an area such as an intersection 
or bridge, take 20 to 30 consecutive images of the area’s perimeter. Take a new image every 
few meters while keeping your camera centered on the center of the surveyed area. Elevate the 
camera above ground level to minimize obstructions, and slightly modify the elevation of your 
camera between images. 
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Figure 17: Surveying an Area 

 Surveying a long road. To survey a long road, divide the road into sections, each about 750 
meters (half a mile) in length. For each section, take 20 to 30 consecutive images from both 
sides of the road. Keep the camera centered on the middle of the road. Maintain an overlap of 
at least 60% between consecutive images. Elevate the camera above ground level to minimize 
obstructions, and slightly modify the elevation of your camera between images.  

 

Figure 18: Surveying a Long Road 
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4.3 Geo-Ref / Scale 

You can choose between Geo-Ref., Scale, or Rough 
Scale as the referencing system for a specific job 
cluster.  
By selecting Geo-Ref you need control point 
measurements in the field, then you’ll need to mark 
them on images, this will add position, orientation, and 
scaling to your output or 3D model. 
While Scale selection will allow you to add scaling-
only to your output or 3D model, without any special 
surveying tools, scaling-only is achieved by measuring 
2 slope distances in the field, then mark each distance 
on 2 images each, it could be very useful for volume 
calculation since it requires scaling only and there’s no 
need for position or orientation to calculate volume.   
Alternatively it is possible to work without geo-referencing or scaling by selecting the “Rough 
Scale” option.   This will basically allow you to start working on the model, while ground control 
points or distances are being measured.  In this option you will need to mark one rough estimate 
of a distance on 2 images. This option can also be used for quickly generating views for different 
purposes such as presentations, where measurements are not necessary. In both scale and 
rough scale mode you will also be required to set the gravity direction. 

 
 
 

4.3.1   Measuring Control Points for Image Geo-Referencing 

The following guidelines and best practices will help you measure your control points in the 
survey area in an optimal way: 

 Measure at least three control points in the survey area. At the minimum, three control 
points should appear each in two of the images of the survey area, which should be 
photographed from different angles, as close as possible to 90°. Measuring and marking more 
control points in more images will improve the resiliency of the geo-referencing process. You 
may measure point coordinates in either a local or a national grid.  
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Figure 19: Measure at Least Three Control Points 

 Choose clearly defined control points. Choose control points that will be unambiguously 
and accurately identifiable in the images. Use available landmarks or deploy your own 
prominent objects in the survey area if no appropriate landmarks are available. Good choices 
for control points are pointed shapes of flat surfaces such street paint marks, or corners of paint, 
tile, or stone patterns on building walls. Corners of a building or tips of objects are good for 
confirming the other control points. Avoid using extended objects as control points. 

 

Figure 20: Choose Clearly Defined Control Points 

 Accurately measure the position and elevation of the control points. Carefully measure 
the position and elevation of control points with an accuracy of better than 2 cm (0.79 inch).  
Make sure you mark the exact and not the approximate location of the measured points on the 
sketch.  Remember, the accuracy of measuring the position and elevation of control points sets 
the accuracy baseline for all the measurements and drawings related to the images. 

 Scatter the control points in the survey area. To attain maximum accuracy, scatter your 
control points across the survey area relative to breadth, depth, and height. Select control 
points on the perimeter of the survey area, so that measurements in the survey area are 
interpolated rather than extrapolated. Make sure they are well scattered in the survey area. 

 Choose control points on more than one plane. To attain maximum accuracy, select 
points at both ground level and elevated positions. 
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Figure 21: Choose Well-scattered Control Points 

Make sure your control points are not all located on the same plane, such as at ground 
level or on a vertical flat façade. Choosing control points that lie all on the same plane will 
degrade the accuracy of the geo-referencing of the photogrammetric model. 

 

Figure 22: Control Points Measured in Many Planes 

4.3.2  Measuring Distances for Image Scaling 

The following guidelines and best practices will help you measure distances in the survey area 
in an optimal way: 

 Measure at least two distances in the survey area - At the minimum, two distances 
should appear in two of the images of the survey area, which should be photographed from 
different angles, as close as possible to 90°. Measuring and marking more distances in more 
images will improve the resiliency of the scaling process.   

 

 Choose clearly defined distances - Choose distances that will be unambiguously and 
accurately identifiable in the images. Good choices for distances are distances between pointed 
objects such as the corners of a building or street marks.  

 

 Accurately measure distances - Carefully measure the distances with an accuracy of 
better than 1 cm (0.4 inch). Remember, the accuracy of measuring the distances sets the 
accuracy baseline for all the measurements and drawings related to the images. 
 

 Choose distances on more than one plane - To attain maximum accuracy, select distances 
at both ground level and elevated positions. 
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5 Calibrating Your Camera 
Before processing your images with DatuGramTM3D, it is important that you calibrate your 
camera, i.e., calculate the internal parameters of your camera and lens system. This includes the 
camera and lens focal length and radial distortions. DatuGramTM3D takes the initial values of 
these parameters, and readjusts them to compensate for any changes in the camera’s internal 
parameters due to the automatic focus of the lens or environmental conditions such as ambient 
temperature changes. 

Note that the internal calibration parameters are different for different camera bodies and 
lenses, thus the calibration procedure should be repeated whenever a new camera body or lens 
is used. DatuGramTM3D will save the calibration parameters of multiple cameras and lenses that 
you use. Also note that the calibration parameters change when using optical zoom, and thus it 
is recommended to use lenses with a fixed focal length, i.e., not equipped with optical zoom. 

Replacing your lens or using a new camera body requires recalibrating the camera and 
lens and saving the new calibration parameters in DatuGramTM3D. 

 
 

As part of the installation process, predefined camera calibration parameters are 
available for some cameras and if you intend to use one of these cameras, you can save time by 
selecting one of the pre-calibrated calibrations. But if, in spite of the fact that you have used our 
best practices, the job results are not suitable, you may need to calibrate your camera rather 
than rely on the pre-calibrated calibrations. Indications for that might be multiple clusters or 
poor accuracy.  

5.1 Calibration Procedure 

The calibration process of the camera and lens includes the following steps: 

 Photographing the survey area or alternatively using a subset of images of the job that will 
be processed.   See section 5.2 for best practice for taking or selecting images to be used in field 
calibration.  

 It is always possible to send the images to our support team, who can create the 
calibration file for you. Then you can simply import it into your library and use it.  To do so send 
the images to support@datumate.com. 
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 Loading images to DatuGramTM3D 

 Getting initial camera parameters from one of the available sources including automatic 
extraction of internal parameters from images 

 Running the calibration process and saving this new calibration 

 Linking the images using the newly generated calibration file 

 Adding Floating Control Points in the Geo-Ref/Scale stage and using the Apply function to 
get an adjusted calibration 

  And, finally saving the final adjusted calibration to the calibration library 

To calibrate your camera, simply follow these simple steps: 

 Click ‘New Calibration...’ from “Images” tab  

 
 

Or from Main Menu -> Tools -> New Calibration… 

 

  
 

 

 Select  one of the available sources for getting the initial camera calibration values in order 
to be able to run the calibration 
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 Adjust camera and lens parameters if needed, hit “Calibrate”, and wait for the calibration 
process to end 
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If an existing calibration is selected from the library or from an existing job, 
mismatches may occur due to incompatibilities between current images selected for calibration 
and the calibration file. Depending on the degree of divergence, select to continue or perform a 
new selection. 

 

When data is extracted from the EXIF metadata, the Focal Length [px] may not be 
identified during the process. You must manually fill in the Sensor Width if it is not there. The 
Sensor Width data can be retrieved from the camera maker or any professional camera web 
site, such as DPREVIEW or from Wikipedia. 

 

If parameters are missing or there is a conflict with the EXIF data, you will be 
requested to select the “Custom” option to edit various fields. 

 

 Click ‘Finish’ and the Calibration Name window shown below will allow you to confirm or 
modify the automatically generated name of your new calibration and optionally 
uncheck/check the option to add it to the calibration library. 

 

Figure 23 - Calibration Name Window 

The new calibration will automatically be selected in the Choose Calibration option as 
shown below 
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 Click the ‘Link’ button to link the images.  Once the link process is done, you will see the link 
result in the right panel as shown below.  If the image set was selected carefully and 
according to the best practice, only one cluster will be generated. 

 

 

 

 Click ‘Next’, or alternatively click on the Geo-Ref/Scale tab name, to move to the Geo-
Ref/Scale stage.   If more than one cluster was generated you will need to select only one of 
the clusters to continue the calibration process with. The final goal in this stage is to add 
Floating Control Points and press the “Apply” button.  This will generate an adjusted 
calibration, which will be the calibration that we need to save (export) and use. 

 Select the cluster you want to work with if more than one exists. 

 Use any of the available model options, Geo-Ref, Scale, or Rough Scale, as long as you have 
enough information to satisfy its minimal requirements.  For example, keep the cluster 
model as a Rough Scale model, and add one Rough Scale and gravity to satisfy the minimal 
requirements of a Rough Scale model.  Refer to section 6.4.2 on how to do so. 

It is preferable to work in Geo-Ref or Scale mode, but if you use the Rough Scale mode, 
make sure the distance you use is reasonably close to reality.  

 

 Add additional Floating Control Points to better adhere images to each other.  Refer to 
section 6.4.9 on how to add FCP’s.  The more FCP’s you add the better your calibration will 
be.   

 Press the “Apply” button, review residuals, and make adjustments following the standard 
work process till you are satisfied with the results. See example below. 
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 Select the menu option “Tools/Export Camera Parameters” as shown below.  This will open 
a window that will allow you to select the cluster of which the adjusted calibration will be 
exported.  Exported calibration can be imported into the calibration library at any time 
using the import function available in the Calibration Library window.  

 

 

Figure 24 - Exporting Adjusted Camera Calibration 

 

5.2 Field Calibration Image Set 

This section describes the best of practice of taking or selecting images for the sake of camera 
field calibration.  

 

 Refer to section 4.2 on best practice for taking images for jobs where illustrations are 
also available. 

 DO NOT use images with sky, water, or flat sand with no features. 
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 DO NOT use images with a lot of glass showing reflections. 

 DO NOT use images with moving objects in them, such as traffic. 

 

For UAV Cameras: 

 Take 18-24 images is a circular mode with equal spacing between them, taken from 
similar distances of about 15-20 meters.  

 All images should be pointing to a center point, with minimum 60% overlap between 
them. 

 Take oblique image at 45 degrees. 

 Images should have low frequency texture such as a stock pile, a rock, or an intersection.  

 

For Ground Cameras: 

 Take 12-18 images is an arc mode with equal spacing between them, taken from similar 
distances of about 15-20 meters.  

 Do not use images that were taken in a straight line.   

 All images should be pointing to a center point, with minimum 60% overlap between 
them. 

 Images should have low frequency texture.  
 

5.3 Calibration Library 

Click Tools > Calibration Library… in the main menu of DatuGramTM3D. 

Click Add, Edit, Delete, Import or Export to modify camera calibration files. 

o Add allows manually adding a new camera calibration file to the Calibration 
Library. 

o Edit permits modifying the calibration parameters, to incorporate external 
parameters or to change the MSE. 

o Delete permits removing a specific camera calibration from the Calibration Library. 

o Import permits importing a camera calibration file into the Calibration Library. 

o Export permits exporting the selected camera calibration file. 
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Figure 25: Camera Calibration Library 

As part of the installation process, predefined camera calibration parameters are 
available for specific cameras. The internal calibration parameters vary for each camera. If the 
job results are not suitable when using pre-calibrated camera you may need to calibrate your 
own camera rather than use the pre-calibrated camera. 
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6 Working with DatuGram™3D 

6.1 Starting DatuGram™3D Application 

The DatuGram™3D application includes a series of opening screens which provide essential 
information about basic requirements and getting started. 

 

 If you do not want these pages to be displayed the next time the application is opened, 
unclick the “Show this at statup” radio button. 

 

 

Figure 26: A Few of the Startup Windows 
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Figure 27: Welcome Screen 

6.2 Working with Jobs 

6.2.1  Opening a New Job 

To begin working with DatuGram™3D – with photographs and measurements of a new façade 
– open a new job. 

At any stage in working with DatuGram™3D you can undo (Ctrl+Z) and redo (Ctrl+Y) 
most of the steps performed. 

Once you have progressed to the next image or stage in the project, your work cannot be 
undone. Undo/Redo activities are per viewed-image or screen. It you move to another image, 
all actions which were “remembered” for Undo/Redo are lost. 

 Click File > New Job in the main menu of DatuGram™3D, or use the shortcut Ctrl+N. 

 Fill in the Job Name in the “Job Properties” dialog box. Use a standard naming convention 
that includes information such as the façade address, date of photograph, camera model 
and lens focal length, e.g.: CityName_StreetName_Date_Canon600D_24mm. 

 Click OK. 

 

Figure 28: “New Job” Dialog Box 
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6.2.2  Opening an Existing Job 

To open an existing job: 

 Click File > Open Job in the main menu of DatuGram™3D or use the shortcut Ctrl+O. 

 Browse to the DatuGram™3D Jobs folder, click the Jobs folder, select the Job file, and click 
Open. The images are displayed in the “Images” window (Figure 30). 

 

 

Figure 29: Opening a Job 

 If not previously selected, in the “Choose Calibration” box, select the appropriate camera 
calibration from the list of calibrated cameras. When possible the system may 
automatically select a suitable calibration based on the camera and lens model, and a 
notification will appear below the “Choose Calibration” drop down. 

 Optional: Click New Calibration… in order to create a new camera calibration (see 
chapter 5). 

 Optional: Click Tools > Calibration Library… in the main menu, in order to import new 
camera calibration to the list (see chapter 5). 

 If needed, click on the “Link” button to link the images.  This may be required if you 
change the camera calibration or if the job was created using certain prior versions of 
DatuGram™3D.  This step also may result is clustering images into groups that may need 
to be manually linked together.   This is covered later in this chapter.  
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 Click Next. The “Geo-Ref/Scale” window is displayed. After clicking OK, the “Images” 
window is displayed and performing job’s tasks can be initiated.   

 

6.3 Step 1: Images – Loading Images, Camera Calibration, 
linking images and Managing of Clusters 

There are five main steps to complete to handle a job from start to end.  This section describes 
the first step followed by steps 2 to 5. 

The first screen displayed after a job is opened is the “Images” window (Figure 30). In this 
window you handle the imagery of the job: loading images, removing images, calibrating the 
camera with which the images were taken, and geometrical linkage of the images. 

 

 

 

Figure 30: “Load Images” Window 

 Click on “Load Images”, and in the “Choose Images” window, browse to the folder in which 
the image files are stored, select the relevant image files and click Open. The system starts 
at this point a 4 step process as follows: 

a. Sanity check – Checking for EXIF Data issues, such as resolution and date 
mismatch.  Sanity check take some time, but it is done only when images are 
loaded, and not what a saved job is opened.   

b. Loading images – Copying images into job folder, 

c. Image Preparation – Preparing all different images for job, and  

d. Blurriness check – Checking if any of the images has a blurry area 
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The selected images are then displayed in the “Images” window.   

 

 

Figure 31: Images Window 

 

Both the Sanity check and the Bluriness check may result in issues that may need to be 
resolved.  Such issues are indicated by showing a warning sign on the image  and also by 
showing the number of images with warning/issues on the bottom left side of the Images 
screen.  These issues may be resolved by right clicking on each screen and selecting the 
resolution action.   

 

 Choose Calibration - If not automatically selected, select the appropriate camera 
calibration from the list of pre-calibrated cameras. If the camera in which images where 
taken, does not exist in the list, then the camera must be calibrated. Click New Calibration… 
in order to create a new camera calibration or click Tools > New Calibration … in the main 
menu.(See Chapter 5).  

 Click Link. The images are automatically linked in clusters (groups of linked images), based 
on homological points.  

6.3.1  Short Baseline issues 

If the link process detects consecutive images with short baseline issues (images that are very 
similar), then the system will indicate that on the right side of the screen and will automatically 
open a window to allow resolving this issue by deleting part of the images.  If you select not to 
resolve some or all of the issues, the message will stay on the screen with an option to press a 
“Resolve…” link to go back and resolve it.   As shown below, the images are grouped and by 
default all marked for deletion except for the first one in each group.  Once you press OK, 
marked images will be deleted and images will have to be linked again. 
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Figure 32 - Resolve short Baseline 

  

6.3.2  Manually Linking Image Clusters 

If the angles of photographing are extreme, images cannot be automatically linked into a single 
cluster of images and several unlinked clusters are created (Figure 34).  This is also indicated 
on the right side of the screen as shown in the figure below.  Also pay attention that each image 
is marked in its bottom left corner as to what cluster it belongs to.  

 

Figure 33 - Multiple image clusters 
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You may select to ignore this and continue your work dealing with several clusters in the jobs, 
which will be basically handled separately throughout the job as sub-jobs.  Otherwise, you have 
the option to attempt to connect the clusters by adding tie points.  To connect image clusters, 
click the Cluster Connector button, which opens the window below.  

 

 

Figure 34: Cluster Connector 

The manual clustering process requires adding sets of 6 or more tie points between each two 
clusters you think it will be possible to link.  These sets of tie point are called connectors.   It is 
possible to add one or more connectors between and two adjacent clusters, but each one of the 
connectors needs to have a minimum of 6 tie points  

If all images were initially linked into one cluster, no merging is necessary and, the 
Cluster Connector button is not displayed. 

If a large number of clusters include one particular image, change the order of the images so 
they reflect their actual appearance in the field where they were taken. 

To add cluster connectors: 

 Click the “Add” button below the connector list. 

 

 Select two clusters from the drop down list and click OK.  This will automatically select 
the last two images of the first cluster and the first two images of the second cluster.  See 
below.  
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Figure 35 - Adding a cluster connector 

 Add at least 6 tie points on all shown images by clicking the “Add” button below the 
manual tie point list, and marking the tie points on all the images with a left mouse click.  
You may zoom images as needed to identify and mark points.  Once the third tie point is 
marked on all images you will start seeing residual values indicating how good your 
markings are.   

 When sufficient tie points have been identified, click the OK button and link images again.  

 Once you are happy with the link process and cluster result, then you can move forward to 
Step 2 = Geo-Ref / Scale. 

Upon loading the images, DatuGram™3D automatically calculates the relative 
orientation of the images by finding homological tie points through state-of-the-art image 
processing algorithms. 

6.4 Step 2: Geo-Ref / Scale 

Starting with DatuGram™3D version 4.5.0, you have the option to select one of 3 working modes 
for each one of the clusters.  See figure below: 
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Figure 36 - Model referencing modes 

For Geo-Ref and Scale clusters you may define as many control points and as many scaling 
distances as you want. For Rough Scale clusters you will be able to define only one rough 
distance.  You may do so by jumping from one mode to the other and adding your GCP’s and 
your scaling distances, which will be described later in this section.  Yet only the last selected 
modes for each cluster will be used in later steps.   

While working with all 3 modes it is possible to add Floating Control Points (FCP’s) to 
strengthen the coherence between images. This will improve the accuracy of all functions, 
especially when the project includes a lot of images.  FCP’s are basically control points with no 
coordinates.  So you may define any clear feature in two or more images and it becomes a 
control point, and you may define as many as you want.   To add an FCP under any mode, you 

can use the ( ) tool bar button and click anywhere on the image to add a new FCP or mark an 
existing FCP.  See full instructions on this in section 6.4.4 below. 

The following pages will describe how to work with the 3 modes starting with Rough Scale, then 
Scale, and finally followed by the Geo-Ref mode. 

 

6.4.1  How to work in the Geo-Ref/Scale stage 

The Geo-Ref/Scale tab sets the basis of how accurate the model will be. Regardless of which 
mode you are in, if you start correctly in this stage, then everything will be right and accurate 
throughout the whole project.  This is particularly important when you work in the Geo-Ref or 
Scale mode as this will set the geo referencing or scaling.  When working in Rough Scale, it is 
assumed that accuracy is not as important at this stage, but could be later if you decide to switch 
the job back to either Geo-Ref or Scale mode.    

For each mode there are some minimal definition requirements the system needs to be able to 
refine the camera position and orientation parameters so they will minimize projection errors.  
This refinement calculation is referred to as Sparse Bundle Adjustment, or SBA. The SBA 
calculation can be re-done at any time to improve the refinement of the parameters, and can 
also be based on different points including GCP’s, FCP’s, new points (not including topo points), 
and distance end points.  The more points you use the better the refinement is, but it takes more 



 

 
 

- 42 - 

time.  These minimal requirements are mentioned in other places in this document, but for 
convenience, here they are again: 

 Geo-Ref minimal requirements – A minimum of 3 Ground Control Points marked in 2 
images at about 90 degrees.  

 Scale minimal requirements – A minimum of 2 distances marked in 2 images with the 
gravity direction set. 

 Rough Scale minimal requirements – Only 1 distance marked in 2 images with the 
gravity direction set. 

Once the minimal definition requirements are met for the selected image cluster, the system 
will calculate the refined parameters.  This is done by clicking the Apply button.   After clicking 
the Apply button you will see the box below indicating the calculation is in progress. 

 

Figure 37 - Pressing the Apply Button 

As shown below, the Apply button has two modes; Fast and Fine.    The Fine mode uses a high 
number of tie points to do the refinement, hence it is more accurate.  The Fast mode on the 
other uses a subset number of tie points, so it takes a very short time to give you some 
preliminary results of residuals.  It is recommended to use the Fine mode the first time you 
satisfy the minimal criteria.  Once this is done, then you can use the Fast mode when adding 
new points.  Once you are done and before you move to the next stage, you should hit the “Apply 
(Fine)” one final time to build a precise model before you move on.  

 

Every time the Apply button is pressed, the system will do a full refinement calculation (SBA). 
This will provide marking accuracy residuals for GCP’s FCP’s and distances depending on the 
mode in which you are working.  Once this refinement is done, the user may elect to add, adjust, 
or delete points or distances.   When this is done, the system gives a message that the model has 
changed and you need to press the Apply button. It immediately updates the marking residuals 
for the point that was changed using a quick transformation calculation, therefore it is not 
necessary to click the Apply button after every change.   

Once you have completed your Geo-Ref, Scale, or Rough Scale and point adjustments, hit the 
Apply button again. This will recalculate the referencing allowing you to go to the Measure & 
Draw routine.  Finally, when you finish all your markings, and hit the Apply button. During this 
process, the system will re-calculate the coordinates of all the new points including topo points, 
and it will display the progress bar shown below.   Once done, it will move to the selected tab. 
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Figure 38 - Calculating New Point Coordinates 

Below is a general recommendation of adding control points or distances for each cluster of a 
new project. 

6.4.1.1 Geo-Ref Clusters  

1. Satisfy the minimal requirement. – Add a minimum of 3 ground control points on two 
different images staying away from images on the edges.  When marking the first set 
of ground control points, select two images that are about 90 degrees from each other. 
Make sure the ground control points appear around the outside of the area or interest.  
This allows the values will be interpolated and not extrapolated.  

2. Press the Apply key.  If the residuals are not good, go back and check your markings 
and adjust where needed, pressing the Apply button again until you have good 
residuals, meaning all residuals are green. 

3. Turn on projections. 

4. Start checking some images that are far from the original images where you marked 
the GCP’s and see if the projections are at where they should be. If needed add more 
ground control points and/or floating control points to improve the projections.  
Please be sure that every control point is added to at least 2 images.  

5. Once finished. Press the Apply button again. 

6. Repeat steps 4 and 5 till you are satisfied with the projections. 

7. You may now move to the Measure & Draw. 

6.4.1.2 Scale Clusters  

1. Satisfy the minimal requirement. – Add distances and set the gravity.   When adding 
the first set of distances, select two images that are about 90 degree to each other. Make 
sure the distances appear in both of them.   Try to use distances that are not very short 
in relation to the area of interest. 

2. Press the Apply key.  If residuals are not good, go back and check your markings and 
adjust where needed. Press the Apply button again until you have good residuals. 

3. Add more distances and/or floating control points to strengthen the ties between the 
images. Make sure you distribute the new distances and floating control points 
throughout the entire cluster. 

4. Press the Apply button again and check residuals.   

5. Repeat steps 3 and 4 as you deem necessary. 
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6. You may now move to the Measure & Draw.  

6.4.1.3 Projections of GCP’s, FCP’s and Distances  

It is possible to show the projections of Control Points as well as Distance end points on 
other images.   Projections are shown after a model is built, meaning after the “Apply” 
key is pressed the first time, on images in the same cluster.   

To turn projections on simply check the Projections check box on the upper right corner 
of the Geo-Ref/Scale screen shown below: 

 

To select what will be projected press on the Projections… link shown in the figure 
above and this will open the window shown in Figure 39 below that will allow you to 
make your selection. The Projection Settings here are global and not for a specific 
cluster. Meaning they can be set and saved for a job regardless if there are Control Points 
or Distances in the job.  Projections of Floating Control Points and Distances projections 
will be made in the cluster they are marked in,   while Ground Control Points projections 
may be marked in images in any Geo-Ref’d cluster if possible. 

 

Figure 39 - Projection Settings 

The Custom… link allows you to select a subset of Ground Control Points to be projected. 
Selection window is shown below. 



 

 
 

- 45 - 

 

Figure 40 - Projection List WIndow 

General guidelines: 

 GCP’s are projected only in Geo-Ref’d clusters.  Selection made here also applies 
to the Measure & Draw window but may be changed there also. 

 FCP’s are projected in all cluster types only in the Geo-Ref/Scale stage. 

 Distance Points are projected only in Scale and Rough Scale clusters only in the 
Geo-Ref/Scale stage. 

6.4.1.4 Show Names 

Check or uncheck the “Names” checkbox to show or hide the point and projection names 
on the images. 

 

6.4.2  Working in Rough Scale mode 

Working in Rough Scale mode means that the model that will be built will be: 

1. Floating - Meaning that it is not anchored to the ground and does not have a perfect 
orientation.  You are required to set the gravity direction, so the model will be correct 
vertically, but it will not have the correct azimuth (Angle from North).   

2. Roughly scaled – Meaning that it will have rough dimensions – The model will be built 
based on the specified rough scale but it will have the right aspect ratios.  

 

Working in this mode is suitable for the following purposes: 
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1. One wants to build a model for a presentation to show the model or advancement in 
building processes or excavations or filling processes without the need to have control 
point measurements.  

2. One has images from a certain job, but does not yet have ground control points or 
distances measured.  In this case it is possible to start all the drawing processes and 
when the survey area is measured, then ground control points or distances can be 
added, and the work can be completed. 

 

To work in rough scale mode, simply select the rough scale option for a specific cluster, follow 
the instructions to define one rough distance and define the gravity similar to what is described 
in “Working in Scale Mode” below, click Apply, and go to Measure & Draw.  Rough scales name 
will start with the letter “R” indicating the measurement was roughly estimated.  

6.4.3  Working in Scale mode 

Working in Scale mode will allow adding a measurement reference to the job.  This will 
allow taking accurate measurements between new points, as well as building right size 
models.  The benefit is that this can be done without any special surveying tools. Stock pile 
volume calculations is ideal for Scale jobs, since volume calculations do not require 
geodetic positions or orientation. 

Scale is easy and can be done by measuring as few as 2 distances in the field, then marking 
these measurements on at least 2 images.  When distances are added, the Distance Marking 
Accuracy measured will provide residuals for both the distances and for end points. This 
will be shown in the right pane of the application similar to the Control Point Making 
Accuracy table.    

To add a distance while working in Scale mode follow the steps below: 

1. Select the distance marking tool  from the tool bar and a distance marker with 
the number 1 is attached to the mouse pointer.  

2. Mouse over to the first end of the distance you wish to mark, and click it.  You may 
zoom in as needed to mark the right point.   It then will prompt you to determine if this 
is a new or existing distance you are adding.   

 

3. If this is a distance you have previously marked on other images, select Existing.  

4. If this is a new distance, enter the measured distance in the field below. 
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5. If you picked an existing distance, select one of the available distances from the drop 
down options. 

 

6. Click OK, and a distance marker with the number 2 is attached to the mouse pointer  

7. Mouse over to the second end of the distance you wish to mark, and click on it.  You 
may also zoom in here as needed to mark the right point. 

8. Repeat the step above to add more distances as needed.  All distances will appear in 
the Distances list as shown below in Figure 41. 

 

 

Figure 41 - Scaling Distances 
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9. Define the model gravity, by clicking on the “Define Gravity” button.  This will open the 
dialog show below, 

 

Figure 42 - Define Gravity Dialog 

As you see, there are two ways to define gravity direction. One is by a vertical line you 
see in one of the images, but if no vertical line exists, it will be possible to define a 
horizontal plane.  Both definitions use existing points including GCP’s, FCP’s, or 
distance end points.  If you do not already have suitable points, you will need to add 
FCP’s for this purpose.    Otherwise make your selection and press OK.  The mouse 

cursor turns to this icon  . 

Select points as instructed.  Each point you select will be marked clearly with an icon 

like this ..  Additionally all points that are participating in the gravity setting 
will be clearly marked with the letter G in the list of points or distances on the top left 
part of the Geo-Ref screen.  Pay attention, the software will do its best to detect the 
direction of the gravity based on the images, but you will always have the option to flip 
the software’s detection with a click of a mouse on the “Flip Gravity” button in the 3D 
Model screen under the View & Export tab.  

10. Once you satisfy all of the requirements of distances and gravity, press the Apply 
button and then move on to Measure & Draw to continue your work. 

 

6.4.4  Working in Geo-Ref mode 

Control points are the measurement points taken in the field using traditional geodetic 
measurement equipment, such as a robotic total station or RTK GPS. With DatuGram™3D, there 
is no need to collect dozens of measured points in the field as is done conventionally. You only 
have to measure a few, well identified points that are uniformly spread over the job’s area. Each 
control point should be a measurement of an object existing on at least two images. The number 
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of required control points is a factor of the complexity of the site but new control points can 
easily be added as you move forward so there is no need to overpopulate an image. 
 

6.4.5  Importing Control Points 

The control point measurement file, containing the project’s control points, should be imported 
at this stage. 

 Click Import and select the measurement file. The “Import Measurement” window is 
populated by the control-points data measured in the field.  It is recommended to have an 
ASCII or text file of your field measured control points. 

 
 

Figure 43: Selecting the Control Points File 
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Figure 44: Import Measurements Window – View of TP (Control Points) File, Prior to Import 

 The “Import Measurement” window (Figure 44) shows how DatuGram™3D parses the 
control-points file. If the parsing is not correct, you can set the correct delimiter, change 
(by dragging) the order of the coordinate columns, and set the decimal separator. The 
default measurement unit is meters but you can change it by selecting other units from 
the dropdown list. 

a. The “<file_name> content preview” field shows the original text as they exist in the 
file. 

b. The “<file_name> filtered preview” field shows the interpretation of the file in 
which the contents have been parsed to Name, N, E, H (coordinate values), Code 
name, Description, and Point Comment. 

 To save the formatted parameters, click New and provide a Format name for the New 
Format. 



 

 
 

- 51 - 

 

Figure 45: Saving Import Measured Points, Format Interpretation 

 To delete a format setting item from the “Format Settings” list, select the item from the 
dropdown list and click Delete. 

 To save a format settings item in the “Format Settings” list, click Save. 

 If point attributes within the TP file are ordered differently from the default order, 
columns can be dragged and reordered. 

 Use the Start Import at Row, Delimiter, Units of Coordinates and Decimal Separator, 
to modify the formatted imported parameters. 

 Click Import. DatuGram™3D checks the control points to verify that a point with the same 
name does not already exist in the job. If it does, the application prompts the user with a 
dialog box to skip, rename or overwrite the existing point. 

During the import process, a control point with a code that already exists in the job’s 
codes library receives that particular code. Other control points remain without codes. 

6.4.6  Marking Control Points 

Images are anchored by control points. Reference points, before being anchored, are called 
projections.  Projections as well as marking residuals are shown after meeting the minimum 
marking requirements.   The screen below shows the basic Geo-Ref/Scale window followed by 
an explanation of its components.   
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Figure 46: “Geo-Ref/Scale” Window 

Left pane: 

Control Points – This is a list of all imported or manually added Ground Control Points and 
Floating Control Points.  If the Control Point is marked on at least one image, an anchor icon 

is shown to the left of the control point name.  The icons are different for GCP’s  and 

FCP’s both on images as well as on the table on the top left.  In the screen shot above 
4 control points are marked on at least one image. 

Images below control points list – Here all the images that the selected control point 
appears in are shown with the control points marked. 

 

Right pane: 

Show Names and Projection – These check boxes enable and disable showing the names 
of the control points and the projections as well as showing the projections themselves.   It 
is possible to select the points that you would like to see projections for by pressing the 
Projections… link on the same line.  Projections are shown after meeting the minimum 
marking requirements. 
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Clusters – a list of image clusters built by the link process with the option to select the 
referencing mode for each cluster.  Selecting a cluster from the list shows the thumbnail 
images of the selected cluster as well as showing one of the cluster images on the center 
display. 

GCP Residuals [m] – in this section the system shows the point with the highest residual 
in the actual measurement unit, meaning meters, feet…  The “Details…” link can be used to 
show all marked points residuals without having to go to the View & Export screen. 

Control Points Marking Accuracy – Residuals of all markings are shown here.  Values are 
automatically shown after meeting the minimum marking requirements, and are updated 
every time a point is added, deleted, or moved.  Colors of residuals indicate their quality.  
Ranges for each color may be set in the Tools/Settings option in the Accuracy Display tab. 

 

Bottom Thumbnail Banner: 

Thumbnails of all selected cluster images is shown here and it allows selecting the image 
you want to work with by clicking or dragging it to the main image display. 

On each thumbnail you may see two indicators as shown below.  In the upper left corner 
you will see the number of control points marked in this image, and in the upper right 
corner you will see the color of the overall tie point detection accuracy on this image. 

 

On the upper right corner of the banner you will have the option to check the option to show 

images of all cluster, and also to open an expanded view of images by pressing the  icon. 

Main Image Display: 

Main display is where all work is done as far as marking and editing the control points.  The 
screen shown below displays an image with all of the different options including 
projections.  
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Figure 47 - Marked Image 

 

 

 To view information about one or more control points, click the Indicator icon ( ) 
and, mouse over the desired control point. The control point will be highlighted and if Names 
was not previously checked, the name of the highlighted point will be displayed. 

Right-click a control point to display a context menu. This permits performing several actions 
on the point, including displaying the Properties of the point. The same context-menu appears 
if you right-click on a control point on the “Control-Points” list in the window’s left pane. 

 

6.4.7  Anchoring Control Points 

To anchor a previously defined ground or floating control point on images: 

 Select a cluster (group of linked images). 

 Then select an image from the selected cluster by clicking on images or dragging to the 
viewer from the thumbnail banner images of from images in the left pane. 

 Click the Point Selection icon ( ). A crossbar cursor appears over the image. 
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To zoom in on a particular area of an image, use the scroll wheel on the mouse to adjust 
the size of the image. 

 

To scroll through an image, right click and hold the mouse right button and drag the 
image in any direction. 

 Zoom into the area of where you want to mark the control point, put the cursor on the 
right position and left click to mark it. . The “Mark Control point” dropdown box is 
displayed.   

Note that the projection marker is to assist in finding the vicinity of the point. You 
should put your mark on where the point was originally measured in the image and not on the 
projection marker itself. 

 Click on the arrow in the “Name” dropdown box (Figure 48) and select the relevant control 
point based on its name and the field sketch (or image) detailing the control points 
measured in the field. 

 Click OK. 

 

Figure 48: Marking Control Points 
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 Repeat this process until you have marked at least three Ground Control Points and as many 
Floating Control Points on at least two images.  It is recommended that you distribute the 
points to identify the width, length, and height of the project.    

Revising the position or coordinates of a control point will change the geo-referencing 
of the photogrammetric model, and will change the coordinates of any new point measured on 
the images. 

 Ground Control Point properties can be edited during this process. Click the Indicator icon 
then, right click on the control point, on the image, or in the list of control points to 
provide a list of operational functions related to each control point. 

 

Figure 49: Control-Point Context Menu 

o Click Select in Viewer to highlight the selected point and display its name. 

o Click Rename to rename a point without changing its coordinates. 

o Click Replace with to replace the point’s name and coordinates with one of the 
points in the TP measurement file. 

o Click Delete to remove a point from the list. Several options are provided: 

 Delete point from entire job. 

 Delete mark from this image only. 

 Delete mark from all images. 

o Click Properties to manually edit the point coordinates (Figure 49). 
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Figure 50: Editing Control-Point Dialog Box 

 Subsequent to the creation of each new control point after meeting the minimum 
requirement will recalculate and display the residuals.  Hence, if residuals get bad after 
adding a point, then you should go back and recheck the position of that point in all images 
it which it is marked.   

 Click on any of the points shown in the “Control-Points” list (left pane) to display all images 
that contain that particular point. Thumbnails of the images are shown below the “Control-
Points” list. 

 Click on a thumbnail in the “Control-Points” list (left pane) to display that image in the main 
window. 

To locate a particular control point, use the “Search” window located at the top of the 
“Control-Points” list. 

6.4.8  Adding a New Ground Control Point 

If a control point is deleted, all its projections will be removed. Similarly, If a control 
point is restored (using the undo function), all its projections will be restored. 

If an important projection is missing in the TP measurement file, a new control point can be 
created. The relevant information with the required parameters should be provided by a 
surveyor who worked in the field. 

 To manually add a new control point click the “+” button below the “Control-Points” list. 
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 In the “New Control Point” window, fill in the coordinates and other related information. 
Provide a code (if available) and description and click OK. The Code is only relevant when 
provided for a measured point by the TPS. 

 

 

Figure 51: “New Control-Point” Dialog Box 

6.4.9  Adding a New Floating Control Point 

 To add a new floating control point, Click the Point Selection icon ( ). A crossbar cursor 
appears over the image. 

 Click on the location on the image where you want to add the new floating control point.  
This will show the dialog below: 

 

 Press on the New FCP button, and the will add a floating control point names FCP_x, where 
x is a running number assigned by the system.  Once you add a new point on one image 
you can anchor it on other images following the same method as adding a pre-defined 
ground control point.  



 

 
 

- 59 - 

6.4.10  The Geo-Referencing/Scaling Marking Accuracy Indicator 

Marking accuracy calculation should be performed in the following instances: 

 After marking at least three control points on two images in the survey area. 

 Whenever any of the existing control points (GCP or FCP) is edited. 

DatuGramTM3D calculates the geo-referencing of the photogrammetric model based on ground 
control points, floating control points, and distances in the images. It compares the relative 
orientation of the images inferred from the geo-referencing to the relative orientation implied 
from the automatic image processing of tie points.  Additionally the user may also include or 
exclude all points mentioned above as well as new points drawn on the images in the calculation 
by setting the SBA (Sparse Bundle Adjustment) options in the SBA tab of the settings window.  

The color of the Marking Accuracy Indicator (green, yellow or red) indicates the accuracy of the 
photogrammetric model. A green light indicates the accuracy is good. A yellow light indicates 
that accuracy of the photogrammetric model is fair, and a red light indicates that accuracy of 
the photogrammetric model is poor. 

 To recalculate the photogrammetric model, click Apply button at any time. 

 Check and edit the exact anchoring of any control point that has large residuals, as 
indicated by yellow or red marking, by comparing it to the field sketch. 

 Repeat this procedure until the Marking Accuracy Indicator is green, or when you are 
satisfied the marking accuracy meets your minimum requirements. 

6.4.11  Marking Accuracy List 

Marking accuracy determines the difference between the marked position and the calculated 
or predicted position of any point. All residuals are important because it shows how accurate 
the marking is. The residual is determined by taking the predicted value and comparing it to 
the marked value.  

Image marking accuracy residuals are always measured in pixels so that their absolute value in 
centimeters or inches is relative to camera resolution and the distance between the camera and 
the object. 

DatuGram™3D is pre-configured so that measurement errors smaller than 3 pixels are colored 
in green, measurement errors of 3 to 4 pixels are colored in yellow, and measurement errors 
larger than 4 pixels are colored in red. These parameters are configurable by the user in the 
Settings window (refer to Section 7.2.1 ). 

1 Check and edit the exact anchoring of any control point that has large residuals, as 
indicated by yellow or red markings, by comparing it to the field sketch, and recalculate 
the geo-referencing of the photogrammetric model. 

2 Click on any point in the residual list in order to view thumbnails, under the “Control-
Points” list (left pane) of all images containing that particular point. 
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6.4.12  Export Camera Calibration 

In the event that the job results are suitable you can use this particular job for future internal 
camera calibration. Suitable results are indicated by the existence of a single cluster with the 
Geo-Referencing Quality Indicator being acceptable (green). 

 In the Tools menu, select “Export Camera Parameters”. 

 In the Tools menu, select “Calibration Library…” option and Import this new Calibration 
file by clicking on the Import button and selecting the file recently saved. 

6.5 Step 3: Measure & Draw – Marking and Creating New 
Points 

The survey drawing is created on this window. To perform this function, you can add map 
entities such as New Points, Polylines, Polygons or Surfaces. Furthermore, linear distances 
between two points can also be measured. Remember that when you have more than one 
cluster, each is handled separately.  So New Points or object marked on one image will be 
projected on images form the same cluster only. 

To establish the coordinates of a new point, the point must be identified on at least two images, 
and preferably more. Any new point marked in one image is automatically found in all others. 

A number of tools are available on the “Measure & Draw” window to facilitate the process of 
creating a survey drawing. 

 

Figure 52: “Measure & Draw” Window 
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6.5.1  Layers and Objects 

6.5.1.1 Working with Layers 

A layer is used to group several map entities into one set. Usually entities of one layer have 
some common attributes that distinguish them from points in other layers. For example, they 
may define a window frame layer or a road sign layer.  Layer are define cross job, so they can 
be used in any cluster.  

The various layers in DatuGram™3D can be checked or unchecked in the “Layers” list, in the 
Show column. This substantially reduces the possibility of confusion if you wish to visually 
concentrate on a specific group of entities. 

By default, when DatuGram™3D opens a new job, it contains one layer called the “default layer”. 

User can right-click on a layer and call up its context menu which has the following options: 

 Delete Layer – deletes the layer and all its contents. 

 Properties – shows the “Layer Properties window, containing layer name, description and 
color and enables editing those properties (  Figure 53). 

 

  Figure 53: Layer Properties Window 

To create a new layer: 

 Click on the + below the “Layers” list in the right pane, to open the “Add Layer” dialog box 
(Figure 54). 
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Figure 54: “Add Layer” Dialog Box with “Color” Selection Dropdown Box 

 In the “Add Layer” dialog box, add a name for the new layer and a description and click on 
the Layer Color button to open the “Color” selection dropdown box. 

 Select a color for the layer. The color assists the user in quickly identifying entities in a 
particular layer. 

 Click OK. 

6.5.1.2 Working with Objects 

Each layer contains its map entities (objects) which are displayed in the “Objects” list below the 
“Layers” list. When you draw map entities, they are automatically associated with the selected 
layer in the “Layers” list. 

 Select an object, and a certain entity or list of entities will be highlighted on the image. 

 Right click on an entity to show the context menu that enables the deletion of the entity. 

In the case of polylines and polygons, only the lines are deleted but not the new-point 
objects. 

6.5.2  The “Measure & Draw” Toolbar 

The “Measure & Draw” toolbar contains the tools presented in Figure 55: 
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Figure 55: The “Measure & Draw” Toolbar 

The Selection and Indication tool is used to: 

 Drag and drop a point to move it, or select the point using left mouse click and move it using 
the keyboard arrows in 1 pixel resolution.  

 Move the mouse cursor over a new point to highlight a new point. When the new point is 
part of a polyline or a polygon, it highlights the connected lines and new points. 

 Select (left-click) a new-point entity to be synchronized with the “New-Points” list. 

 Activate (right-click) the context menu of a new point. 

 

Figure 56: New-Point Context Menu 

The New-Point Marking tool is used to create a new point. 

The Polyline Marking tool is used to create a sequence of new-point entities. Each adjacent 
pair is connected by a straight line. 

The Polygon Marking tool is used to create a sequence of new-point entities. Each adjacent 
pair is connected by a straight line. The first new point and the last new point are connected 
forming a closed polygon. 

The Topo-surface Sketching tool is used to designate a polygon topo-surface border. After 
drawing the topo-surface border, DatuGram™3D calculates a set of topographic points (topo-
points) in the form of a points-cloud. This cloud represents the topography of the topo-surface 
enclosed by the topo-surface border. 

The Ruler Selection tool is used to measure the linear distance between two points. 
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6.5.3  The New-Points List 

The “New-Points” list contains all the new-point objects in the job, whether they are standalone 
points or part of polyline or polygon. 

The “New-Points” list has an attached search box. Searching can be done by name. Typing a 
new-point’s name will show the appropriate named points in the list. 

 Select a point from the “New Point” list. Large image thumbnails are displayed below the 
list. These thumbnails refer to the images in which the selected New Point is marked. 

 Right-click on a New Point to display the New-Points list context menu. Various functions 
are provided to manage new points, as shown in Figure 57. 

 

Figure 57: New-Point List Context Menu 

6.5.4  The New-Point Properties Bar 

The “New-Point Properties” bar is used to name new points and determine other related 
properties. 

 

Figure 58: “New-Point Properties” Bar 

6.5.4.1 Using the “New-Point Properties” Bar to Mark a New New-Point 

To mark a new point, perform the following steps: 

 In the “New-Points Properties” Bar click New. 
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 Access the “Naming” field. This field contains the name of the to-be-marked new point. 
The name is automatically created and is always one digit greater than the previous name. 
The following table provides examples of new-point names: 

 

Previous Marked New-
Point Name 

Current to-be-Marked 
New Point Name 

1 2 

100 101 

ABC ABC1 

ABC0 ABC1 

ABC01 ABC02 

72A 72A1 

 Alternately, in the “Naming” field, type a desired name manually. This will be the name 
base for the following new markings until you type another name. 

 Use the “Code Selection” List box to select a point code, from the existing list. 

6.5.4.2 Using the “New-Point Properties” Bar to Update an Existing New Point 

To selects an existing new point: 

 Click Existing on the “New-Points Properties” bar. 
In the “Naming” field the name of the currently selected point is highlighted in the “New-
Points” list. If another existing new-point update is needed, select another point from the 
dropdown list. It will be synchronized with the “New-Points” list. 

 In the “Code Selection” List box, the code of the currently selected new point is displayed. 
You select another code for the existing point. 

In order to have selectable point codes in the “New-Points Properties” bar, you must 
load codes to the job’s codes library. Please refer to Section 7.2.2.1. 

6.5.5  Viewing Images 

Marking entities on an image requires a high degree of accuracy. DatuGram™3D provides three 
images viewing modes to facilitate precise positioning of your mouse: 

 For a single image view, in the image marking area, select one image – either from the 
thumbnails ruler at the bottom of the screen or from the “New-Points Image” list on the 
left. The selected image is displayed and occupies the whole image marking area. 
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 For a split screen view, click on the split screen image in the “Screen Mode” bar. Drag and 
drop images from the thumbnails ruler into the screen quarters. 

Split screen mode is useful to assure a specific marking can be projected on several 
images or if you want to view existing new point projections or markings. 

 

Figure 59: “Images Screen Mode” Bar 

 To display an image in a separate window, right-click on the image in the “New-Point” list. 
A context menu pops up showing ‘”Preview” option. Select the option, and the image is 
opened in a new system menu. 

 

Figure 60: Selecting Displaying Image in a Separate Window 
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The “Preview” mode is useful if you are using two monitors. You can then drag the new 
window to another monitor and visually scan small features in the image. The image occupies 
the whole screen and can be zoomed and panned and a filtering radio button allows you to show 
all new points on the image or just the selected one. 

6.5.6  Marking New Map Entities 

6.5.6.1 Creating a New Point 

To create a new point: 

 Select the layer (or create a new one) with which you want the new point to be associated. 

 Select the mapped item you want to mark. 

 Select the image/images that best display that item. 

 From the “Measure & Draw” toolbar, select the “New-Point” marking tool. 

 On the “New-Point Properties” bar, verify that the automatically-provided name is 
suitable. Modify the name if required. 

 Verify that the automatically-provided code for the new point is suitable. Modify the code 
if required. 

 To add a comment to the new point you are about to mark, click on the Point Properties 
button and type the comment. 

 Position the crossbar cursor on the desired location on the image and click it. A gray-
colored drop-shaped icon is displayed. On the right pane an indication is provided that 
object marks are being searched on other images. After several seconds, the search 
process completes and the color of the drop-shaped icon changes to green, yellow or stays 
gray. The different colors indicate the following: 

 

Figure 61: Example of Auto-Find Indication 

o Green: indicates the point was found in at least two other images (apart from the 
currently marked one). 

o Yellow – indicates the point was found in only one other image (apart from the 
currently marked one). 

o Gray – indicates the image was not found in any other image. 
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On a Yellow or Gray icon color marking, we should select another image and mark the 
current point manually as "Existing" point. After this action a new Auto-Finding 
process will start while the two manual marks will not be changed 

Use Crtl+click to initiate a snap function to help you draw accurately. The cursor snaps 
onto each location, linking the points. 

6.5.6.2 Creating a New Polyline 

To create a new polyline: 

 Repeat steps 1 to 3 from Section 6.5.6.1 (Creating a New Point). 

 From the “Measure & Draw” toolbar, select the “Polyline Marking” tool. 

 Repeat steps 5 to 7 from Section 6.5.6.1 (Creating a New Point). 

 The first point of the polyline is created. Move the mouse to the location of the next point. 
A trailing line indicates that the new point will be marked as part of a polyline. 

 Repeat step 3 as many times as required, until you reach the penultimate point. 

 To mark the final point of the polyline, double-click the mouse. A new polyline is created 
having the color of the layer with which it is associated. 

During the process of marking new points for a polyline or a polygon, it is not 
necessary to wait until the search process has been completed for each point. Mark as many 
points as necessary and the process of searching points in other images continues in the 
background for all points. 

6.5.6.3 Creating a New Polygon 

 Repeat steps 1 to 3 from Section 6.5.6.2 (Creating a New Polyline). 

 From the “Measure & Draw” toolbar, select the “Polygon Marking” tool. 

 Repeat steps 5 to 7 from Section 6.5.6.2 (Creating a New Polyline). 

 The first point of the polygon is created. Move the mouse to the location of the next point. 
A trailing line indicates that the next new point will to be marked as part of a polygon. 

 Repeat step 3 as many times as required, until you reach the penultimate point. 

 To mark the final point of the polygon and close it with line connecting to the first 
polygon’s point, double-click the mouse. A new polygon is created having the color of the 
layer with which it is associated. 
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While marking new polyline or polygon points, you can change each polyline’s or 
polygon’s new-point properties by setting them in the “New-Point Properties” bar. 

6.5.6.4 Creating a New Topo-surface Entity 

 For each area you want to cover, such as a stock pile, create a layer specifically for it, and 
add all topo surface for the area of interest under the newly defined layer 

We recommend creating special layers that include only topo-surface objects. This 
ensures that only the desired topo-surface features are included in the mesh. 

 Repeat steps 1 to 3 from Section 6.5.6.2 (Creating a New Polyline). 

 From the “Measure & Draw” toolbar, select the “Topo-surface sketching tool. 

 If this is the first topo-surface in the job, DatuGram™3D presents a message notifying you 
that pre-processing is required. This takes several seconds. 

When creating a new topo-surface, you cannot change the name of the topo-surface. It 
is provided automatically. 

 Circumscribe the topo-surface you want to reconstruct (calculate its topography), with a 
boundary polygon (use the same techniques as described in marking a new polygon, 
Section 6.5.6.3).  You must define several topo surfaces to nicely cover the area of interest 
or the stock pile.  Tope surfaces can be drawn on different images, but must be under the 
same layer. 

 When each topo-surface boundary is closed, DatuGram™3D displays a process notification 
in the right pane stating that it is calculating topo-points for the drawn topo-surface. This 
process takes several seconds and when it completes, the topo-surface should contain 
several topo-points within its boundary. 
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Figure 62: Topo-surface Reconstruction – Soil Pile Example 

A topo-surface’s boundary polygon is not composed of new-point entities. It is made 
of per-image points, so do not expect to find the topo-surface boundary in images other than 
the one used to draw it. 

 

 

The best way to get accurate topo-points is to: 

- Choose images that have good contrast and no blurring. 

- Choose images that are not among the first two images and not among the last two images. 

The principal region in the Topo-Surface is visible in four images at least. 

Points which lie close together in the image of the principal region must also lie close together 
in the 3D, e.g. in this case the topo-surface on the left image should not include both points but 
be split into two topo-surfaces. 
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6.5.7  Working with the Ruler Tool 

 To measure the distance between two measured points, select the Ruler icon. 

 Click on two points and the distance between them is shown in the “Ruler” dialog box. 
Points may be control points or new points. Three distances are provided: 

o Vertical distance 

o Horizontal distance 

o Slope distance 

 

Figure 63: “Ruler” Dialog Box 

6.5.8  Other “Measure & Draw” Window Properties 

6.5.8.1 Show Control Point Projections 

To show selected Ground Points projections, check the projections check box on the 
upper right corner and follow the procedure explained in section 6.4.1.3 above to 
select what Ground Control Points will be projected.   FCP’s and Distances may not be 
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projected.  The Projections window here has a bottom part that you can simply ignore 
for this purpose. 

6.5.8.2 Show Names 

Check or uncheck the “Names” checkbox to show or hide the point and projection 
names on the images. 

6.5.8.3 New Point Projections 

There are two types of New Points Projections as follows: 

 New Points Projection in the same cluster – These are automatic projection. 

 Cross Cluster New Point Projections – These are projections of new points between Geo-
Referenced clusters that the user has control over which clusters’ new points will be 
projected on the remaining ones. 

 

Both types are explained below. 

Same cluster projections: 

 The new point projection is displayed as a small red square. The projection appears 
when any new point is marked on at least three images, but not on the current image. 

New point mark can be added by clicking on a new point projection when in edit 
mode. After clicking on the new point projection, the new point projection (red 
square) will disappear. 

 Epipolar line is a hint of the new point location on current image when this point is 
marked only on one image (not on current image) 

 Epipolar circle is a hint of the new point location on current image when this point is 
marked on at least two images (not on the current image)  

The figure below shows an example of new point projections in the same cluster.  A 
polyline of 2 points was added in one image.  One point was found in at least 3 images 
so it is shown as a red square projection, while the second one was found only in 2 
images so it is shown as an Epipolar circle.  
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Figure 64 - New Point projection in same cluster 

 

Cross Cluster Projections 

1. Both clusters must be Geo Referenced 

2. The user turns projections on and checks the cluster he/she wants projected on other 
clusters by clicking on the “Projections…” link and selecting the clusters in the bottom 
half of the expanded   Projection Settings window shown below. 

 

Figure 65 - Expanded Projections Settings Window 
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3. The new point drawn on an image in one cluster is displayed as an orange square on 
other clusters.  See figure Figure 66 below showing two points projected from another 
cluster and 2 points projected from the same cluster. 

 

Figure 66 - New Point Projection on other clusters 

  

4. The user will be able to snap onto any of the orange projections using the Ctrl button 
while adding new objects other than single points.   New points will not be added at 
points projected from other clusters, hence in the 3D viewer in View & Exports objects 
using cross cluster points will not be shown unless you show both clusters.   

 

6.6 Step 4: Approve – Reviewing, Correcting and Approving 
Marked Points 

The “Approve” window is used to review and correct a job’s measurement points. Information 
about the reliability and accuracy of the points is presented in tabular form. This screen 
provides tools to search, sort and filter the points. You can view each point on all the images in 
which it appears, correct the locations of new-point entities or delete new points and topo 
points. 

6.6.1  Approving New Points 

The coordinates of all new points and their measurement accuracy are automatically calculated 
when the “Approve” window is accessed. The coordinates and error ellipses of the control 
points appear in the table in the left pane. When a point is clicked on, all associated thumbnails 
are displayed (Figure 67). You can move the location of new-point markings to improve 
accuracy. 
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Figure 67: “New Points Approve” Window 

6.6.2  Approving Topo Points 

The coordinates of all new topo points and their measurement accuracy are automatically 
calculated when the “Approve” window is accessed. The coordinates and error ellipses of the 
topo points appear in the table in the left pane. When a point is clicked on, all associated 
thumbnails are displayed (Figure 68). 

Topo-point locations cannot be edited. 

 

Figure 68: “Topo Points Approve” Screen 
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6.6.3  General Approval Guidelines 

The error ellipses of the measurements are presented in metric units. DatuGram™3D is pre-
configured as follows: 

 Measurement errors smaller than 3 cm are colored green. 

 Measurement errors of 3 to 4 cm are colored yellow. 

 Measurement errors larger than 4 cm are colored red. 

These parameters are configurable by the user using the Tools/Settings in the Accuracy Display 
tab. 

Measurement errors may be caused by (1) the point not being accurately sampled in the images, 
(2) the distance of the point from the camera is too great, or (3) there is an error in the software 
automation algorithms. To verify that the point is accurately sampled in the images: 

 Click on the desired point in the table in the “Approve” window. 

 Browse through the different images to view where the point was sampled and correct it 
as required. Images can be zoomed so it is very simple to achieve very accurate 
positioning on the “Approve” window. 

 To delete one point, click on the line to highlight it and then click “Delete points”. 

 To delete several points, right click on the lines to be deleted, one after the other, to 
highlight them and then click Delete. 

 Displayed points can be filtered by selecting one of the following criteria and typing the 
name of that criterion. 

o New points can be filtered by name, layer name or code. 

o Topo points can be filtered by name, layer name or topo-surface. 

 If a specific point is inaccurate or erroneous, it can be deleted. To delete a single mark, 
click on the image and then click on the X (window closing) or on the Delete Image 
Marks button. To delete several marks, hold the Control key and click on several image 
windows, then click on Delete Selected Images. 

6.7 Step 5: View & Export – Previewing and Exporting to 
Exchangeable Formats 

In the “View & Export” window you can view all surveying map data created and collected by 
DatuGram™3D. In this window you can create the final output as a text file, a PDF file or a DXF 
file. In addition, you can manage the content of the export by selecting the desired exported 
layer, control points (used, all or none) and which layer is used to create the mesh in the 3D 
Model window. 
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Figure 69: “View & Export” Window 

The application provides views and information of the project from six different perspectives: 

 3D Model: Displays a 3-dimensional view of the selected layers. The colors of the objects 
displayed in the 3D Model are in accordance with the colors of the layers. This window has the 
following functionality: 

o Hovering over a point shows the point name. 

o Showing point names checkbox which allows you to hide or display the names of all 
measurement points. 

o Clicking and holding the mouse’s right button to pan over the view. 

o Using the mouse wheel to zoom in and out. 

o Clicking and holding the mouse’s left button to rotate the view. 

 

o Note: We may encounter some false positive points in our job. We can fix the false positive 
issue by moving the point marks manually in "Approve" window or by selecting images one 
by one in "Measure & Draw" tab. 

Sometimes the lines fail to appear when polygons or polylines are marked by snap to 
control point projections. To rectify this situation, select "Show all points" in the Control Points 
combo box. 

 Projection Preview: Presents a top-down view of the entities-to-be-exported, reflecting 
the vector-projection which has been set. If no-projection has been selected, nothing is shown. 
This window also provides panning and zooming. 
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 Control Points: Gives a list-view of all control points positions and residuals in meters. 

 New Points: Gives a list-view of all selected new points. 

 Topo Points: Gives a list-view of all selected topo points. 

 Volume Calculation: Provides ability to calculate volume concealed in measured 
structures. 

 Volume calculation requires that either Geo-Ref or Scale cluster to be selected. It won’t 
work on a 3D model without any scaling property. 

 

6.7.1  Exporting Job Data 

To export the measurements as final output files or as input to CAD software for further 
processing, in the right pane, perform the following steps: 

 Select the layers to be included in the export by using the checkboxes to the left of the 
layers’ names. 

 Select which layers to mesh, by using the checkboxes to the right of the layers’ names. 

 Select which control points to include in the export (none, just the used control points or 
all the control points). 

 Select the output file format: DXF, ENH, NEH or PDF. 

 Select the projection: 

a. No projection. 

b. Horizontal plane – set the H value of the horizontal plane. You can type a specific 
value or set the height by selecting a new point from the list so its height will set 
the horizontal plane of reference. 

c. Vertical plane – sets a plane, perpendicular to the horizon, which passes through 
two selected new points. All measurements, then, undergo vector-projection. 

 Click Export. 

 

Management of data in the “View & Export” window does not alter the data stored by 
DatuGramTM3D. Changes are made only for preview and export. 
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6.7.2  Volume Calculations 

6.7.2.1 Background 

 

Figure 70: The “Volume Calculation” Window 

The “Volume Calculation” window (Figure 70), in the “View & Export” window, is a tool which 
is used to calculate volume of material enclosed within a relief structure. This is useful in 
construction works, earth works, tunneling and mining, where large quantities of soil have 
accumulated or are planned for excavation and measuring of such an aggregation is necessary. 

Volume calculation is done based on one or two surface objects. In the first case, DatuGram™3D 
creates a convex hull, a virtual surface enclosing the given physical surface. Then, calculation of 
the volume enclosed between the physical surface and the convex hull is performed. In the 
second case, DatuGram™3D calculates the volume of material enclosed between two given 
physical surfaces. 

In the current version of DatuGram™3D, in order to calculate a volume, the base surface must 
fully include the selected surface (Figure 71). 
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Figure 71: Supported Surfaces Geometry 

6.7.2.2 Usage Flow 

To calculate volumes perform the following steps: 

 Populate the “Surfaces” list with at least one Surface object.  If the current job already has 
a Layer object containing measured points, they will automatically be converted to 
Surface objects and be displayed in the “Surfaces” list and in the “Base Surfaces” 
dropdown list. 

 Surface objects can also be added by importing points from an XYZ file. Click on Import 
surface from file… The “Import Surface from File” window (Figure 72) opens. 

 Browse to the required points XYZ file, parse the point lines as needed and click on 
Import. The “Import Surface from Point File” window closes and the “Add Surface” 
window (Figure 73) opens. 

 Type a name and description for the new surface (by default the surface will get the file 
name) and set the surface color (by default the color will be as different as possible from 
the colors of the existing surfaces). 

 Click OK. The file’s points will be imported to the new Surface object. 
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Figure 72: Import Surface from Points File Window 

 

Figure 73: Add Surface Window 

 In the “Surfaces” list, using the checkboxes in the left column, check the surfaces to be 
displayed (Figure 72). Revise them and determine if they are ready for volume calculation. 

 The following user interface controls can help during the visually scanning of the surface 
prior to calculating the volume. 

o If a point is identified as erroneous, it can be deleted by performing the following 
steps: 

 Hover over the point; the point name is displayed.  

 Zoom in to the point. 

 Right click on the point. 

 Click on Add to Delete Queue, if this is the first point you mark for deletion the 
will also open the “Delete Points” dialog, where you can see and edit what you 
plan on deleting. 

 Once you are done Click on the “Delete Points” button to delete all points in the 
list.  See figure below 
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Only Topo-points can be deleted. New points may be deleted from the “Approve” tab. 

o If the surface is not accurate go to the “Measure & Draw” window in order to draw 
more topo-surfaces or to add new points where needed. 

 

Figure 74: Deleting the Selected Points 

 After a surface is selected (from the “Surfaces” list), click on the Calculate Volume button 
or add a base surface from the “Base Surfaces” list to the calculation and then click 
Calculate. The surface volume is calculated and displayed in the “Calculated Volume 
Properties” window (Figure 75). 
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Figure 75: Calculated Volume Properties Window 

 If only one Surface is used for the volume, the “Calculated Volume Properties” window 
shows the surface used for the volume calculation. If two surfaces (surface and base surface) 
are used for the volume calculation, both surfaces will be displayed in the window. 

The window shows the Fill and Cut calculated values in the measuring unit used throughout the 
job (m3 or ft3). 

Throughout this document: 

 

“Fill” refers to the amount of material accumulated above the base ground level. 
“Cut” refers to the amount of material subtracted below the base ground level. 

 To name the volume, as it will be seen in the “Volumes” list, in the “Calculated Volume 
Properties” window add a name. The calculated volume can be added to the “Volumes” list 
by clicking Add to Volumes. The volume is added as a new record to the list of volumes. 

 When all volume calculations are completed and added to the “Volumes” list, a volume 
report can be exported. Two types of file formats can be exported: PDF and CSV. From the 
“Export File Format” section, select the desired format and click Export…. 
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Figure 76: Volume Calculation – PDF Report 

6.7.2.3 Other Possible Actions 

The following functions can also be utilized to enhance volume calculations. 
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 Changing Surface Properties: Right click Surface in the “Surfaces” list to access its context 
menu. Select Properties. The “Surface Properties” window opens. In this window you can 
modify the Surface name, description and color. 

 

Figure 77: Surface Properties Window 

 Exporting Points Collection of a Surface: Right click Surface in the “Surfaces” list to 
access its context menu. Select Export to Points File…. A window opens. Here you can define 
the file location and name, and a file is saved in ASCII format with XYZ coordinates. 

 Changing Volume Properties. Right click Volume in the “Volumes” list to access its 
context menu. Select Properties... The “Calculated Volume Properties” window opens. Here 
you can modify the volume name. 

 

Figure 78: Calculated Volume Properties Window 

 Recalculating Volume. Right click Volume in the “Volumes” list to access its context menu. 
Select Recalculate…. This option let you update the volume value in the event that one of the 
surfaces involved has been changed. The “Volume Recalculation Properties” window opens 
letting you view the changes in the volume values. You can decide whether to update the value 
for Volume or leave it as is. The date and time where the last calculation was made is also 
displayed. 
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Figure 79: Volume Recalculation Properties Window 

 Removing Surface from “Surfaces” List: Right click Surface in the “Surfaces” list to access 
its context menu. Select Remove. If the Surface is based on a Layer, this menu option will not 
be displayed.  Only surfaces based on a points file can be deleted. 

 Removing Volume from “Volumes” List.  Right click Volume in the “Volumes” list to 
access its context menu. Select a particular volume and then click Delete. The volume will be 
removed from “Volumes” list. 
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7 DatuGram™3D Menu Options 
This section explains some of the menu options when their use is not self-
explanatory.  

7.1 File Menu 

7.1.1  Save as… 

Saves the current job under a new name and continue to work with the newly saved job. This 
means that the current job will stay as it was after the last save, and if new changes were made 
after the last save they will be in the new job 
 

7.1.2  Export 

Similar to the Save as except that the current job is saved under a new name with all changes 
up to the moment the Export job was done, but the system continues to work on the current 
job. 

7.1.3  Close & Archive Job 

Similar to the “Close Job” except that it does also a temporary file cleanup to free disk space.  
This option should be used when you know you are done with this job.  “Close Job” does not 
clean up temporary file, hence opening the job next time will be faster that after “Close & 
Archive Job”. 

 

7.2 Tools Menu 

7.2.1  Settings Window 

The Settings windows provide control over basic configuration settings for DatuGramTM3D. 

 To access the Settings windows, click Tools > Settings. 

7.2.1.1 General Settings 
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Figure 80: The “General Settings” Window 

 In the Working Folder set where DatuGramTM3D stores its temporary data. In order for 
DatuGramTM3D to work as expected, its working folder should be located on a local drive 
(SSD is preferred), not on network drive. 

In some computers associated with networks, it is common for folders that contain 
users’ documents to reside on network storage by default. For regular documents (word 
processing, working sheets, etc.) this is quite acceptable but it will not foster effective work 
with DatuGramTM3D. DatuGramTM3D performs a vast number of image and mathematical 
processing and needs a fast storage device. Only local storage devices can provide sufficient 
performance results. Because of this, it is recommended that the DatuGramTM3D working folder 
resides on a local drive. An SSD is recommended. 
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7.2.1.2 Measurement Units 

 

Figure 81: The “Measurement Units” Window 

In the “Distance units” dropdown box, the following measurement units can be selected: 

 Meter 

 US Foot 

 International Foot 

 Yard 

In the “Volume units” dropdown box, the following measurement units can be selected: 

 The distance units "Meter" can work with volume units of “Meter” only 

 The distance units "US-Foot" can work with volume units of either “US-Foot” or “Yard” 

 The distance units "Int. Foot" can work with volume units of either “Int. Foot” or “Yard” 

 Click OK to set the measurement unit for the whole job. 
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7.2.1.3 Accuracy Display 

 

 

Figure 82: The “Accuracy Display” Window 

 Set the range of residual measurement errors (green, yellow or red) as displayed in the 
Quality Control report (as a fraction of meters). 

7.2.1.4 Interior Orientation 

 

Figure 83: “The Interior Orientation” Window 

 Modify the information in this table in order to change measurements used by 
DatuGram™3D to establish residual values. 
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7.2.1.5 SBA 

 

Figure 84: “SBA” Window 

 Modify what points will be used in the SBA (Sparse Bundle Adjustment) calculation when 
the Apply button is pressed in the Geo-Ref / Scale window. It is very important to be very 
careful when setting these options as it will improve the accuracy of the model, but it may 
slow the process of calculations.   

 

7.2.2  Managing and Using Codes and Blocks 

Codes and blocks are attributes of map entities used in most common surveying CAD software. 

7.2.2.1 Managing Codes 

Code is metadata associated with a map entity that relates it to a specific family of entities. For 
example, code could indicate that a specific new-point entity is part of the entities related to 
mapping window frames or semaphores. A code has a name and a description. Each map entity 
can have only one code. 

In DatuGram™3D each new-point entity has an associated code. By default, a new point has the 
code named “0” with description “Default”. You can change the new-point code to one of the 
codes that exist in the job’s codes library. In order to have codes in the codes library, you must 
load its commonly used list of codes from the job. 
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7.2.2.2 Working with the “Point Codes Library” Window 

 To access the “Point Codes Library”, click Tools > Point Codes Library. 

 

Figure 85: “Point Codes Library” Window 

 The following functions are available: importing a codes library file, exporting a job’s 
codes to file, creating a new code, editing an existing code or deleting one. 

7.2.2.3 Importing Codes Library File 

 Click Import. 

 Select the codes library text file. 

 Confirm the import. 
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Figure 86: Point Codes Loaded from Codes Library File 

If the system encounters names of existing codes, the “Naming Conflict” dialog box 
offers options to skip, rename, or overwrite the point. 

7.2.2.4 Exporting Job’s Codes to a Text File 

 Click Export. 

 Type the name of the file to hold the exported codes library. 

 Confirm the export. 

7.2.2.5 Creating new Point Code 

 Click New. 
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Figure 87: “Add New Point Code” Window 

 Type the name and description for the new code. 

 Click OK. A new point code is added to the job’s codes library. 

7.2.2.6 Editing an Existing Point Code 

 From the point codes list, select the code you wish to change. 

 Click Edit. 

 

Figure 88: Edit Existing Point Code – Edit Point Code Window 

 Edit the name and/or description of the code. 

 Click OK and the changed code values are saved. 

7.2.2.7 Deleting an Existing Point Code from the Job’s Codes Library 

 From the point codes list, select the code you wish to delete. 

 Click Delete. 

7.2.2.8 Using Blocks 

A Block is the unit used by surveying software applications to store metadata associated with 
mapping entities and the graphical symbol representation of the entity. Thus, a block is a data 



 

 
 

- 95 - 

structure that combines an icon and metadata attributes. In DatuGram™3D blocks are used 
when the surveying map is exported to DXF format. 

Each new-point entity is associated with a block that has the same graphics symbol and the 
following attributes: 

Attribute Number Attribute Name Attribute Data Type 

1 Point Name text 

2 Point Comment text 

3 Code Name text 

4 Code Description text 

5 North double 

6 East double 

7 Elevation double 

8 Accuracy North double 

9 Accuracy East double 

10 Accuracy Elevation double 

11 Measurement Unit string 

7.3 Help Menu 

The following sections present the main Help menu options. 

7.3.1  About DatuGram™3D  

Clicking on “About” opens the “About” window. This window shows the product Name, Version, 
License information, and other applicable messages.  The window below appears if you have a 
valid license with a maintenance agreement expiration date more than 30 days away  
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Figure 89: About Window 
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In other cases where the maintenance agreement is about to expire, you will get a reminder of 
that.  This message may also appear at startup when the automatic check for update is done, 
but will be labeled “Validate Maintenance”. 

 

If the maintenance agreement date is not found or has already expired, you will also get notified 
as shown below. These messages may also appear at startup when the automatic check for 
update is done, but will be labeled “Validate Maintenance”. 

       

 

7.3.2  Checking for DatuGram™3D Software Update 

Click on Check for Update, so that DatuGram™3D will communicate with Datumate’s server to 
look for a newer version of the application. 

3. If a new version is found and you have a valid maintenance agreement, DatuGram™3D will 
inform you that a newer version exists and it can be downloaded (Figure 90). Follow 
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instructions to download and save the installation file. After installation file is downloaded, 
the installation starts automatically.  

 

Figure 90: Software Update Window 

4. If a new version is found and you do not have a valid maintenance agreement, 
DatuGram™3D will inform you that a newer version exists and it can be downloaded (Figure 
91). 

 

 

Figure 91: Version Available but no Maintenance Agreement Message 

 If the most recent version is installed, an appropriate notification is displayed (Figure 92). 
 

 

Figure 92: Version Up-to-Date Message 

 

7.3.3  Opening the Welcome Screen 

 Click on Welcome Screen to open the Welcome window. 
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Figure 93: Welcome Screen 

The Welcome window is divided into three columns: 

Left Column – Mini Jobs Manager: The left column is the Recent Jobs manager. Clicking on the 
Start button, in the top square, opens the help menu that has a Start button which activates the 
Job Properties window used to create a new job. 

The bottom square contains a list of links with names of recent jobs. Clicking on each link will 
open the linked job. Clicking the Open Job button will open a file dialog to let you select and 
open an already existing job. 

Middle Column – Video Tutorials: The middle column contains internet hyperlinks to 
DatuGram™3D video tutorials located on YouTube. Clicking on each Play button will open the 
appropriate video in the system’s default browser. This feature requires internet connection 
and the latest version of Flash Player, or using Google Chrome browser. 

Right Column – Sample Jobs: The right column contains links to several guided sample jobs, 
stored on the Datumate’s server. To use and learn from a sample job, download the job from 
Datumate’s server to your PC (click Download), and click Open, to view the job within 
DatuGram™3D.  Follow instructions in the manual to work with these jobs.   

 

7.3.4  Basic Steps Presentation 

 Click on Before You Start to open a series of pages containing explanations about the 
basic steps for using DatuGram™3D (Figure 94 is the first slide of this series). 
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Figure 94: First Slide from Basic Steps Presentation 
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About Datumate 

Datumate is a leading vendor of geodetic expert systems. Datumate software products, 
combining technological innovation and geodetic expertise, support land surveyors worldwide 
by improving productivity of field personnel, quality control and management of surveying 
project. Among Datumate’s customers are the Survey of Israel, Israel’s national mapping 
agency, as well as numerous leading land surveying firms worldwide. 

To learn more, please refer to: www.datumate.com 

 


